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Product notice

This guide describes features that are
common to most models. Some features may
not be available on your computer.

Software terms

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to
be bound by the terms of the HP End User
License Agreement (EULA). If you do not
accept these license terms, your sole remedy
is to return the entire unused product
(hardware and software) within 14 days for
a refund subject to the refund policy of your
place of purchase.

For any further information or to request a
full refund of the computer, please contact
your local point of sale (the seller).



Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP Folio 13  PC

Processors Intel® Core™ i5-2467M 1.6GHz processor SC turbo up to 2.3GHz (3MB L3 cache, dual core 17
W)

 Intel® Core™ i3-2367M 1.4 GHz processor (3MB L3 cache, dual 17W)

Chipset Intel® HM65 Express platform controller hub (PCH)

Graphics Intel® HD Graphics 3000 discrete-class graphics. Supports BD and or HD-DVD playback with HD
decode, and DX11 support and HDMI support

Panel 13.3" high-definition (HD) light-emitting diode (LED), BrightView (1366x768) display; (2.85mm)
Shuriken, 200 nits

 All display assemblies include 2 wireless local area network (WLAN) antenna cables.

 Supports 16:9 wide aspect ratio

 Support for non-flush glass panel cover (non-PMMA)

Memory One memory module slot

 DDR3-1333MHz single channel support (DDR3-1600 downgrade to 1333)

 Supports up to 4096 GB of system RAM

 Supports the following configuration: 4096-MB total system memory (4096×1).

Hard drives mSATA SSD

 128 GB: 128-GB SSD

Optical drive External USB optical drive (computer USB ports support 2A current)

 SATA

 12–7 mm tray load

 Supports the following external optical drives:

● Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive

● DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

Audio and video Single digital microphone

 Two integrated stereo speakers
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Category Description

Audio and video
(continued)

HP TrueVision high-definition webcam (fixed, no tilt, 1280×800 by 30 frames per second)

Ethernet Integrated 10/100/1000 GB network interface card (NIC)

Wireless Integrated WLAN options by way of wireless module

 Two WLAN antennas built into display assembly

 Supports the following WLAN formats:

● Intel® Centrino® Wireless-N 1030 + Bluetooth combo w/ *2 antennas (802.11 b/g/n,
Bluetooth 3.0)

● Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter

● Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

External media
card

Push-pull insertion/removal

 HP Multi-Format Digital Media Reader supports the following digital card formats:

● MultiMediaCard

● Secure Digital (SD) Card

● Secure Digital High-Capacity (SDHC) Card

● Secure Digital Extended Capacity (SDxC) Card

Ports ● 3-pin AC power

● Audio-in (mono microphone), supports jack detection

● Audio-out (stereo headphone), supports jack detection

● HDMI version 1.3b supporting 1080p, 1920 ×1080 @ 60Hz

● RJ-45 (Ethernet, includes link and activity lights)

● USB 3.0 (1 port)

● USB 2.0 (1 port)

Keyboard/pointing
devices

97% Duracoat, island-style keyboard, no spill-resistance (in black finish)

 TouchPad with multi-touch gestures

 Taps enabled as default

Power
requirements

Supports the following HP AC adapters:

● 65-W (non-smart) PFC RC V EM 3-wire HP AC adapter

 Supports the following batteries:

● 6-cell, 59 WHr 5.4 AH Li-ion battery
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Category Description

Operating system Preinstalled:

● Windows 7 Home Basic (64- and 32-bit)

● Windows 7 Home Premium (64- and 32-bit)

● Windows 7 Professional (64- and 32-bit)

Serviceability End-user replaceable part: AC adapter
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2 External component identification

Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with
wireless local area networks (WLANs).

(2) Webcam Records video and captures still photographs.

To use the webcam, select Start > All Programs >
Communication and Chat > CyberLink YouCam.
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Item Component Description

(3) Internal display switch Turns off the display or initiates Sleep if the display is
closed while the power is on.

NOTE: The display switch is not visible from the outside
of the computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.
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Buttons and other top components

Item Component Description

(1) Internal microphone Records sound.

(2) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep.

● When the computer is in the Sleep state, press the
button briefly to exit Sleep.

● When the computer is in Hibernation

NOTE: For select models, the Intel® Rapid Start
Technology feature is enabled at the factory. Rapid
Start Technology allows your computer to resume
quickly from inactivity. For more information, refer to
Using Sleep or Hibernation, refer to the HP
Notebook User Guide.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options.

(3) Speakers (2) Produce sound.
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Keys

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Displays system information when pressed in combination
with the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Action keys Execute frequently used system functions.

(5) Windows applications key Displays a shortcut menu for items beneath the pointer.
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Lights

Item Component Description

(1) Power light ● White: The computer is on.

● Blinking white: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(2) Webcam light On: The webcam is in use.

(3) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(4) Wireless light ● White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or
a Bluetooth® device, is on.

● Amber: All wireless devices are off.

(5) Caps lock light On: Caps lock is on.
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TouchPad

Item Component Description

(1) TouchPad light ● On: The TouchPad is off.

● Off: The TouchPad is on.

(2) TouchPad on/off button Turns the TouchPad on and off.

(3) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(4) Left TouchPad button Functions like the left button on an external mouse.

(5) Right TouchPad button Functions like the right button on an external mouse.

Rear

Component Description

Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
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Left side

Item Component Description

(1) Power connector Connects an AC adapter.

(2) AC adapter/Battery light ● White: The computer is connected to external power
and the battery is fully charged.

● Amber: A battery is charging.

● Blinking white: The battery charge level is 12% or
less (recharge the battery as soon as possible).

● Off: The computer is not connected to external
power.

(3) RJ-45 (network) jack Connects a network cable.

(4) HDMI port Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or
audio component.

(5) USB 3.0 port Connects optional USB 3.0 devices and provide
enhanced USB power performance.

NOTE: The USB 3.0 port is also compatible with USB
1.0 and USB 2.0 devices.

(6) Digital Media Slot Supports the following digital card formats:

● Secure Digital (SD) Memory Card

● Secure Digital Extended Capacity (SDxC) Memory
Card

● Secure Digital High Capacity (SDHC) Memory Card

● Ultra High Speed MultiMediaCard (UHS/MMC)

(7) Hard drive light ● Blinking white: The hard drive is being accessed.

NOTE: All references to the hard disk drive in this
guide refer to the solid-state (SSD) drive.

(8) Power light ● White: The computer is on.

● Blinking white: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.
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Right side

Item Component Description

(1) USB 2.0 port Connects optional USB devices.

(2) Audio-out (headphone) jack/audio-in
(microphone) jack

Connects optional powered stereo speakers,
headphones, earbuds, a headset, or television audio.
Also connects an optional headset microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety and Environmental
Notices.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: The microphone function is operational only
when used with a headphone/microphone unit that has a
4-conductor audio connector.
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Bottom

Item Component Description

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during
routine operation.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag, which is located on the bottom of the computer.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer major components

Item Component Spare part
number

(1) Display assembly

(2) Keyboard (includes keyboard cable):
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Item Component Spare part
number

 In black finish:

 For use in Thailand 673656-281

 For use in Canada 673656-121

 For use in Japan 673656-291

 For use in Latin America 673656-161

 For use in South Korea 673656-AD1

 For use in Taiwan 673656-AB1

 For use in the United States 673656-001

 For use in the United Kingdom and Singapore 673656–031

 For use in France 673656–051

 For use in Italy 673656–061

 For use in Saudi Arabia 673656–171

 For use in Russia 673656–251

 For use in the Netherlands 673656–B31

 For use in Spain 673656–071

 For use in Switzerland 673656–BG1

 For use in Denmark, Finland, Norway 673656–DH1

(3) Power button board

NOTE: The top cover spare part kit includes the power button board and cable and the
TouchPad and cable.

672357-001

(4) Top cover (includes power button board and cable and TouchPad and TouchPad cable): 672357-001

(5) TouchPad button board (includes cable)

NOTE: The top cover spare part kit includes the power button board and cable and the
TouchPad and cable.

672357-001

(6) Power connector cable (includes bracket) 672361-001

(7) Memory modules (2, PC3, 10600, 1333-MHz):  

 4 GB 641369-005

(8) Hard drive (does not include the hard drive bracket, connector cable, isolators, or screws.)

 128-GB solid-state drive 672616-001

(9) Speakers (includes cables) 672353-001

(10) WLAN module:

 Intel® Centrino® Wireless-N 1030 + Bluetooth combo w/ *2 antennas (802.11 b/g/n,
Bluetooth 3.0)

631956-005
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Item Component Spare part
number

 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-005

 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo AdapterSPS-
WLAN 802.11bgn+BT4 BC HMC 1x1 VAL

657325-005

(11) RTC battery: 672349–001

(12) System board 672351–001

672352–001

(13) Fan-Heat sink (includes replacement thermal material) 672355-001

(14) Fan-Heat sink 672354-001

(15) USB/Audio board 672358-001

(16) Battery:

 6-cell, 59 WHr 5.4AH Li-ion battery 671602-001

(17) Base enclosure 672356-001
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Mass storage devices

Item Component Spare part number

(1) Optical drive:

 Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive 659941-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 659940-001

(2) Hard drive 

 128-GB solid-state drive 672616-001

 Screws (not illustrated)
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Miscellaneous parts

Component Spare part number

AC adapter (non-smart):

65-W PFC RC V EM 3-wire AC adapter (non-smart) for use only in India 613149-001

65-W PFC RC V 3-wire AC adapter (non-smart) for use in all countries and regions except India 613149-001

Power cord (3-pin, black, 1.83-m):

For use in Australia 490371-011

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Korea 490371-AD1

For use in Argentina 490371-D01

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in Europe 490371-021

For use in Switzerland 490371–111

For use in the United Kingdom and Singapore 490371–031

Screw Kit 672359-001
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Sequential part number listing

Spare part number Description

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061 Power cord for use in Italy (3-pin, black, 1.83-m)

490371–111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

613149-001 AC Adapter (non-smart) RC V 3-wire for use in all countries and regions except India

631956–005 Intel® Centrino® Wireless-N 1030 + Bluetooth combo w/ *2 antennas (802.11 b/g/n, Bluetooth
3.0)

641369-005 4-GB memory module (PC3, 10600, 1333-MHz)

655795-005 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter

657325-005 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

659940–001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

659941–001 Blu-ray ROM DVD±R/RW Super Multi Double-Layer Drive

671602-001 6-cell, 59 WHr 5.4AH Li-ion battery

672349-001 RTC battery for use only with computer models without WWAN capability

672350-001 Display assembly for use with computer models equipped with WLAN only capability in black finish
(includes WLAN antenna cable and transceivers)

672351–001 System board for use only with computer models equipped with an Intel 1.4 GHz processor
(includes processor and replacement thermal material)

672352–001 System board for use only with computer models equipped with an Intel 1.6 GHz processor
(includes processor and replacement thermal material)

672353-001 Speaker Kit (includes left and right speakers and cable)

672354-001 Fan-Heat sink

672355–001 Fan-Heat sink (includes replacement thermal material)

672356-001 Base enclosure 
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Spare part number Description

672357-001 Top cover in black finish (includes power button board and cable and TouchPad and
TouchPad cable)

672358-001 USB/Audio board

672359-001 Screw Kit 

672361-001 Power connector cable (includes bracket)

672362-001 Thermal pad

672363-001 Rubber Kit (includes two rear corner covers and four rubber feet)

672616-001 128-GB solid-state drive only (does not include bracket, connector cable, isolators, or screws)

673656-001 Keyboard in black finish for use in the United States (includes keyboard cable)

673656–031 Keyboard in black finish for use in the United Kingdom and Singapore (includes keyboard cable)

673656–051 Keyboard in black finish for use in France (includes keyboard cable)

673656–061 Keyboard in black finish for use in Italy (includes keyboard cable)

673656–071 Keyboard in black finish for use in Spain (includes keyboard cable)

673656-121 Keyboard in black finish for use in Canada (includes keyboard cable)

673656-161 Keyboard in black finish for use in Latin America (includes keyboard cable)

673656–171 Keyboard in black finish for use in Saudi Arabia (includes keyboard cable)

673656–251 Keyboard in black finish for use in Russia (includes keyboard cable)

673656-281 Keyboard in black finish for use in Thailand (includes keyboard cable)

673656-291 Keyboard in black finish for use in Japan (includes keyboard cable)

673656-AB1 Keyboard in black finish for use in Taiwan (includes keyboard cable)

673656-AD1 Keyboard in black finish for use in South Korea (includes keyboard cable)

673656–B31 Keyboard in black finish for use in The Netherlands (includes keyboard cable)

673656–BG1 Keyboard in black finish for use in Switzerland (includes keyboard cable)

673656–DH1 Keyboard in black finish for use in Denmark, Finland, Norway (includes keyboard cable)
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Preliminary replacement requirements 21



Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 77 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag, which is found on the bottom of the computer.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to the
base enclosure in the locations illustrated below. All 4 feet are available in the Rubber Kit, spare part
number 672363-001.

▲ Remove the four rubber feet from the base enclosure.

Base enclosure

Description Spare part number

Base enclosure 672356–001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the base enclosure screws:
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▲ Turn the computer face down, remove the 16 Phillips PM 2.0×6 screws, and remove the base
enclosure screws.

CAUTION: Before removing the base enclosure screws, do not use a pressure of more than 3.0
kgf-cm screw torque for the 3 Phillips PM 2.0x6.0 screws in the following locations:
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Keyboard

NOTE: The keyboard spare part kit includes a keyboard cable.

For use in country or region: Spare part number: For use in country or region: Spare part number:

Keyboard in black finish:

For use in the United States 673656-001 For use in Latin America 673656-161

For use in Canada 673656-121 For use in Thailand 673656-281

For use in Japan 673656-291 For use in Taiwan 673656-AB1

For use in South Korea 673656–AD1 For use in the United Kingdom and
Singapore

673656–031

For use in France 673656–051 For use in Italy 673656–061

For use in Saudi Arabia 673656–171 For use in Russia 673656–251

For use in The Netherlands 673656–B31 For use in Switzerland 673656–BG1

For use in Denmark, Finland,
Norway

673656–DH1 For use in Spain 673656–071

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

Remove the keyboard:

1. Turn the computer right-side up with the front facing you.

2. Partially open the computer.

3. At the right side of the computer, insert a screwdriver or similar thin tool into the top cover release
area, pressing upwards until the top cover starts to disengage from the computer.
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4. Lift the right side of the top cover, and then press upwards behind the Backspace key to release
the keyboard from the top cover.

5. Lift the rear edge of the keyboard, gently swing the keyboard forward slightly, and disconnect the
keyboard's zero insertion force (ZIF) cable (1).

6. Disconnect the keyboard light cable (2) .

7. Remove the keyboard (3).

Reverse this procedure to install the keyboard.
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Top cover

NOTE: The top cover spare part kit includes the power button board and cable and the TouchPad
and cable.

Description Spare part number

Top cover 672357-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

When replacing the top cover, be sure that the TouchPad button board and cable (see TouchPad button
board on page 34) are removed from the defective top cover and installed on the replacement
top cover.

Remove the top cover:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer.
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3. Disconnect the following cables:

(1) Power button board cable

(2) TouchPad button board cable

4. Lift the rear edge of the top cover until the left and right sides disengage from the base enclosure,
and remove the top cover.

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board 672357-001

Before removing the Power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).

Remove the Power button board and cable:

1. Turn the top cover upside down, with the back edge toward you.

2. Remove the 2 Phillips PM 2.0x3x0 screws securing the Power button board to the top cover (1).

3. Remove the Power button board (2).

NOTE: The Power button board's cable is attached to the board.
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TouchPad button board

Description Spare part number

TouchPad button board (includes cable) 672357-001

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

Remove the TouchPad button board and cable:

1. Turn the top cover upside down, with the back edge toward you.

2. Remove the 5 Phillips PM 2.0×3.8 screws (1) that secure the TouchPad button board to the
top cover.

3. Remove the TouchPad bracket (2).

4. Remove the TouchPad button board and cable (3).

Reverse this procedure to install the TouchPad button board and cable.
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Battery

Description Spare part number

6-cell, 59 WHr 5.4AH Li-ion battery 671602-001

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

Remove the battery:

1. Turn the computer right-side up, with the front toward you.

2. Disconnect the battery cable.

3. Remove the 2 Phillips PM 2.0×3.0 screws that secure the battery to the computer (1).
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4. Support the display panel while lifting the battery slightly, and then slide it forward (2). Remove
the battery from the computer (3).

CAUTION: Make sure that you balance the battery carefully so that it is not damaged.

Reverse this procedure to install the battery.

Display panel

Description Spare part number

13.3-in, LED, BrightView SVA display panel 672350-001

Before removing the display panel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).
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Remove the display panel:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer.

3. Disconnect the display panel cable from the system board (1).

4. Disconnect the USB/Audio board cable from the system board (2).

5. Disconnect the #1 and #2 WLAN antenna cables from the WLAN module (3).

NOTE: The #1 WLAN antenna cable is connected to the WLAN module #1 terminal. The #2
WLAN antenna cable is connected to the WLAN module #2 terminal. For more information, see
WLAN module on page 38,

6. Ensure that the cables are released from the routing clips, the interior computer channels, and the
right speaker clips (4).

7. Remove the 5 screws (1) securing the display panel to the computer. There are 3 screws on the
left hinge and 2 screws on the right hinge.

NOTE: Support the display panel as you are removing the screws.
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8. Lift and remove the display panel (2).

Reverse this procedure to install the display panel.

WLAN module

Description Spare part number

Intel® Centrino® Wireless-N 1030 + Bluetooth combo w/ *2 antennas (802.11 b/g/n, Bluetooth
3.0)

631956-001

Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).

Remove the WLAN module:

1. Disconnect the USB/Audio board cable from the system board (1).

2. Disconnect the #1 and #2 WLAN antenna cables from the WLAN module.

NOTE: The #1 WLAN antenna cable is connected to the WLAN module #1 terminal. The #2
WLAN antenna cable is connected to the WLAN module #2 terminal.

3. Remove the Phillips PM 2.0×2.5 screw (3) that secures the WLAN module to the system board.
(The WLAN module tilts up.)

4. Remove the WLAN module by pulling the module away from the slot at an angle (4).

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion into the
memory module slot.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors.
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USB/Audio board

Description Spare part number

USB/Audio board 672358–001

Before removing the USB/Audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).

Remove the USB/Audio board:

1. Disconnect the USB/Audio board cable from the system board (1)

2. Disconnect the Phillips PM 2.0x2.0 screw securing the USB/Audio board (2).

3. Remove the USB/Audio board (3).
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RTC battery

Description Spare part number

RTC battery 672349-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).

Remove the RTC battery:

1. Disconnect the RTC battery cable from the system board (1).

2. Remove the RTC battery (2). Use a thin, non-conductive tool to remove the RTC battery from the
socket on the system board. (The RTC battery is also attached to the system board with double-
sided tape.)

Reverse this procedure to install the RTC battery on computer models. When installing the RTC battery,
make sure the “+” sign faces up.
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Hard drive

Description Spare part number

128-GB mSATA solid-state drive (SSD) 672616-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).

Remove the hard drive:

1. Remove the 2 Phillips PM 2.0×2.5 screws (1) that secure the hard drive to the computer. (The
hard drive tilts up.)

2. Pull the hard drive to the right(2).

3. Remove the hard drive (3).

Reverse this procedure to reassemble and install the hard drive.
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Memory module

Description Spare part number

4-GB memory module (PC3, 10600, 1333-MHz) 641369-001

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the
memory module. (The memory module tilts up.)

CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch
the components on the memory module.

2. Slide the memory module forward (2).
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3. Remove the memory module (3).

Reverse this procedure to install a memory module.

Speakers

Description Spare part number

Speaker Kit (includes left and right speakers and cable) 672353-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35).

Remove the speakers:

1. Turn the computer, with the front edge toward you.

2. Release the speaker cables from the clips (1).
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3. Release the 2 Phillips PM 2.0×3.0 screws securing each speaker. (2)

4. Remove the speakers and cables (3).

Reverse this procedure to install the speakers.

System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only with computer models equipped with an Intel 1.4 GHz processor, but not WWAN
capability (includes replacement thermal material)

672351-001

For use only with computer models equipped with an Intel 1.6 GHz processor but not WWAN
capability (includes replacement thermal material)

672352-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29),

6. Remove the top cover (see Top cover on page 31).
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7. Remove the battery (see Battery on page 35).

8. Remove the WLAN module (see WLAN module on page 38).

9. Remove the hard drive (see Hard drive on page 42).

10. Disconnect the display panel cable from the system board (see Display panel on page 36).

11. Remove the speaker (see Speakers on page 44).

12. Remove the power connector and cable (see Power connector cable on page 48).

13. Remove the USB/Audio and cable (see USB/Audio).

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● RTC battery (see RTC battery on page 41)

● Memory module (see Memory module on page 43)

● Power connector cable (see Power connector cable on page 48)

● Fan (see Fan/Heat sink on page 50)

● Heat sink (see Fan/Heat sink on page 50)

● WLAN module see (WLAN module on page 38).

● Hard drive (see Hard drive on page 42).

● USB/Audio (see USB/Audio)

● Display panel cable (see Display panel on page 36).
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Remove the system board:

1. Remove the 4 Phillips PM 2.0×2.0 system board screws.

2. Lift the right side of the system board (1) until it rests at an angle.

3. Remove the system board (2) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.
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Power connector cable

Description Spare part number

Power connector cable (includes bracket) 672361–001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Remove the display panel (see Display panel on page 36).

8. Disconnect the battery cable (see Battery on page 35).

9. Remove the speakers (see Speakers on page 44)

Remove the power connector cable:

1. Turn the computer, with the right side toward you.

2. Disconnect the power connector cable (1) from the system board.

3. Remove the double-sided tape (2) from the power connector.

4. Remove the power connector cable (3).
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Reverse this procedure to install the power connector cable and bracket.
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Fan/Heat sink

Description Spare part number

Fan 672354-001

Heat sink 672355-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of
the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature
sensor and is designed to turn on automatically when high temperature conditions exist. These
conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the base enclosure screws (see Base enclosure on page 27).

5. Remove the keyboard (see Keyboard on page 29).

6. Remove the top cover (see Top cover on page 31).

7. Disconnect the battery cable (see Battery on page 35),

Remove the fan:

1. Turn the computer, with the front toward you.

2. Disconnect the fan cable (1) from the system board.

3. Remove the 4 Phillips PM 2.0×3.0 screws securing the heat sink (2), and the 2 Phillips PM
2.0×3.0 screws securing the fan (3).
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4. Remove the fan and heat sink (4).

5. Remove the double–sided tape securing the fan to the heat sink (1) and remove the fan (2).

Reverse this procedure to install the fan and the heat sink.
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5 Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility
Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility
includes settings for the types of peripherals installed, the startup sequence of the computer, and the
amount of system and extended memory.

NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer from
operating properly.

Starting Setup Utility

NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only if
USB legacy support is enabled.

To start Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility.

Changing the language of Setup Utility

1. Start Setup Utility.

2. Use the arrow keys to select System Configuration > Language, and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility

To navigate and select in Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

2. Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:

● To exit Setup Utility menus without saving your changes, press the esc key, and then follow the on-
screen instructions.

– or –

Use the arrow keys to select Exit > Exit Discarding Changes, and then press enter.

● To save your changes and exit Setup Utility menus, press f10, and then follow the on-
screen instructions.

– or –

Use the tab key and the arrow keys to select Exit > Exit Saving Changes, and then
press enter.

Your changes go into effect when the computer restarts.

Displaying system information

1. Start Setup Utility.

2. Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility.

3. Use the arrow keys to select Exit > Load Setup Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, press f10, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Exit > Exit Saving Changes, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Exiting Setup Utility

● To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

● To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Setup Utility.

1. Start Setup Utility (BIOS).

2. Use the arrow keys to select Main.

3. To exit Setup Utility (BIOS) without saving your changes, use the tab key and the arrow keys to
select Exit > Exit Discarding Changes, and then press enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Windows 7—Select Start > Help and Support > Maintain.

Windows XP—Select Start > Help and Support, and then select the software and
drivers update.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.
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BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Windows 7—Open Windows Explorer by selecting Start > Computer.

Windows XP—Open Windows Explorer by selecting Start > My Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe). The BIOS
installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact HP
support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.

To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 29.16 cm 11.48 in

Depth 2.15 cm 8.46 in

Height (front to back) 2.11 to 3.19 cm 0.83 to 1.26 in

Weight

With 6-cell battery 1.60 kg 3.53 lb

With 3-cell battery 1.46 kg 3.22 lb

Input power

Operating voltage and current 18.5 V dc @ 3.5 A - 65 W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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13.3-inch display specifications

 Metric U.S.

Dimensions

Height 16.50 cm 6.50 in

Width 25.34 cm 11.60 in

Diagonal 33.66 cm 13.30 in

Number of colors 262,144

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 mm × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 2.0 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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7 Backup and recovery

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and restore it if ever needed.

This chapter provides information on the following topics:

● Creating a set of recovery discs or a recovery flash drive (HP Recovery Manager software feature)

● Performing a system restore (from the partition, recovery discs, or a recovery flash drive)

● Backing up your information

● Recovering a program or driver
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Restoring the system
If the computer hard drive fails, you must use a set of recovery discs or a recovery flash drive to restore
your system to its factory image. Ideally, you have already used HP Recovery Manager to create these
tools immediately after software setup.

NOTE: All references to the hard disk drive in this guide refer to the solid-state (SSD) drive

For issues other than hard drive failure, you can restore your system by using the HP Recovery partition,
rather than by using recovery discs or a recovery flash drive. To check for the presence of a recovery
partition, click Start, right-click Computer, click Manage, and then click Disk Management. If
the recovery partition is present, a Recovery drive is listed in the window.

CAUTION: HP Recovery Manager (partition or discs/flash drive) restores only software that was
preinstalled at the factory. Software not provided with this computer must be reinstalled manually.

Creating restore media
HP recommends that you create either a set of recovery discs or a recovery flash drive so that you can
restore your computer to its original factory state if the hard drive fails, or if for any reason you cannot
restore using the recovery partition tools. Create these discs or the flash drive after setting up the
computer for the first time.

NOTE: HP Recovery Manager allows the creation of only one set of recovery discs or one recovery
flash drive. Handle these recovery tools carefully, and keep them in a safe place.

NOTE: You can use an optional external optical drive (purchased separately) to create recovery
discs, or you can purchase recovery discs for your computer from the HP Web site. If you use an
external optical drive, it must be connected directly to a USB port on the computer, not to a USB port
on an external device, such as a USB hub.

Guidelines:

● Purchase high-quality DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. 

NOTE: Read-write discs, such as CD-RW, DVD±RW, double-layer DVD±RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the HP Recovery Manager software.

● The computer must be connected to AC power during this process.

● Only one set of recovery discs or one recovery flash drive can be created per computer.

NOTE: If you are creating recovery discs, number each disc before inserting it into an optional
external optical drive (purchased separately).

● If necessary, you can exit the program before you have finished creating the recovery discs or
recovery flash drive. The next time you open HP Recovery Manager, you will be prompted to
continue the backup creation process.
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To create a set of recovery discs or a recovery flash drive:

1. Select Start > All Programs > Security and Protection > HP Recovery Manager > HP
Recovery Media Creation.

2. Follow the on-screen instructions.

Performing a system recovery
HP Recovery Manager software allows you to repair or restore the computer to its original factory state.
HP Recovery Manager works from recovery discs, a recovery flash drive, or from a dedicated recovery
partition on the hard drive. 

NOTE: A system restore must be performed if the computer hard drive fails or if all attempts to correct
any functional computer issues fail. A system restore should be used as a final attempt to correct
computer issues.

Note the following when performing a system restore:

● You can restore only the system that you have previously backed up. HP recommends that you use
HP Recovery Manager to create either a set of recovery discs or a recovery flash drive as soon as
you set up the computer.

● Windows has its own built-in repair features, such as System Restore. If you have not already tried
these features, try them before using HP Recovery Manager to restore your system.

● HP Recovery Manager restores only software that was installed at the factory. For software not
provided with this computer, you must either download the software from the manufacturer's Web
site or reinstall the software from the disc provided by the manufacturer using an optional external
optical drive (purchased separately).

Using the dedicated recovery partition 

When using the dedicated recovery partition, there is an option to back up pictures, music and other
audio, videos and movies, recorded TV shows, documents, spreadsheets and presentations, e-mails,
Internet favorites and settings during this process.

To restore the computer from the recovery partition, follow these steps:

1. Access HP Recovery Manager in either of the following ways:

● Select Start > All Programs > Security and Protection > HP Recovery
Manager > HP Recovery Manager.

– or –

● Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then, press f11 while the “F11
(System Recovery)” message is displayed on the screen.

2. Click System Recovery in the HP Recovery Manager window.

3. Follow the on-screen instructions.
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Restoring using the restore media

1. If possible, back up all personal files.

2. Insert the first recovery disc into an optional external optical drive (purchased separately), and
then restart the computer.

– or –

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

NOTE: If the computer does not automatically restart in the HP Recovery Manager, the computer
boot order needs to be changed.

3. Press f9 at system bootup.

4. Select the external optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press f9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for recovery flash drive:

1. Insert the flash drive into a USB port.

2. Restart the computer.

3. Press esc while the computer is restarting, and then press f9 for boot options.

4. Select the flash drive from the boot options window.

Backing up and recovering your information
It is very important to back up your files and keep any new software in a safe place. As you add new
software and data files, continue to create backups on a regular basis.

How completely you are able to recover your system depends on how recent your backup is.

NOTE: A recovery from your most recent backup needs to be performed if the computer has a virus
attack or if any major system components fail. In order to correct computer issues, a recovery should
first be attempted before a system restore is attempted.
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You can back up your information to an optional external hard drive, a network drive, or discs. Back
up your system at the following times:

● At regularly scheduled times

TIP: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Guidelines:

● Create system restore points using the Windows® System Restore feature, and periodically copy
them to an optical disc using an optional external optical drive (purchased separately) or an
external hard drive. For more information on using system restore points, refer to Using Windows
system restore points on page 64.

● Store personal files in the Documents library and back up this folder periodically.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+prt sc.

To copy the entire screen, press prt sc.

3. Open a word-processing document, and then select Edit > Paste. The screen image is added to
the document.

4. Save and print the document.

Using Windows Backup and Restore

Guidelines:

● Be sure that the computer is connected to AC power before you start the backup process.

● Allow enough time to complete the backup process. Depending on file sizes, it may take over an
hour.

To create a backup:

1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to schedule and create a backup.

NOTE: Windows® includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.
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Using Windows system restore points

A system restore point allows you to save and name a snapshot of your hard drive at a specific point in
time. You can then recover back to that point if you want to reverse subsequent changes.

NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.

You also can create additional restore points to provide increased protection for your files and settings.

When to create restore points

● Before you add or modify software or hardware

● Periodically, whenever the computer is functioning optimally

NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Create a system restore point

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click Create, and then follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click System Restore.

5. Follow the on-screen instructions.
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8 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in
industry-standards based HP Business Notebook PC systems and provide general instructions for
restoring nonvolatile memory that can contain personal data after the system has been powered off and
the hard drive has been removed.

HP Business Notebook PC products that use Intel-based or AMD®-based system boards contain volatile
DDR memory. The amount of nonvolatile memory present in the system depends upon the system
configuration. Intel-based and AMD-based system boards contain nonvolatile memory subcomponents
as originally shipped from HP assuming that no subsequent modifications have been made to the
system and assuming that no applications, features, or functionality have been added to or installed on
the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC
system, personal data can remain on volatile system memory (DIMMs) for a finite period of time and
will also remain in nonvolatile memory. The steps below will remove personal data from the notebook
PC, including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of
these steps are disclosed in the Maintenance and Service Guides available for HP PC products
available on the product support pages at www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal
data. Restoring or re-programming nonvolatile memory that does not store personal data is neither
necessary nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near
the bottom of the display, or press the ESC key to display the start up menu, then press F10 .
If the system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities
menu. Select System IDs, and then select the tag that has been set. Press the spacebar
once to clear the tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then
select DriveLock password. Select the desired hard drive. Click Disable protection,
enter the existing master DriveLock password, then press Enter to confirm and return to the
prior menu. Repeat this procedure if more than one hard drive has a DriveLock password.
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f. If an Automatic DriveLock password is set, select the Security menu, scroll down to
Automatic DriveLock, then select the desired hard drive and disable protection. Repeat
this procedure if more than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the
warning message.

h. Select the File menu, then Save Changes and Exit.

i. Reboot the system. If the system has a Trusted Platform Module and/or fingerprint sensor, one
or two prompts will appear: one to clear the TPM and the other to reset fingerprint sensor.
Press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel Centrino with
VProTM, reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select
System Configuration, then AMT Options. Then select Un-configure AMT on next
boot. Select Save, then Yes. Select the File menu, and then select Save Changes and
Exit. Reboot the system and confirm that you want to un-configure AMT.

j. If the optional Intel Anti-Theft Technology (AT) was activated, contact the provider to
deactivate it.

k. If the optional Absolute® Software Computrace® management and tracking service was
activated on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application
that, ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10
when prompted near the bottom of the display, or press ESC to display the start up menu,
then press F10. Select the Security menu and scroll down to the Utilities menu. Select
Disk Sanitizer and select the desired drive. For a higher level of protection, select
Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard
drive capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a
third party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup
by powering on the system and pressing F10 when prompted near the bottom of the display.
Select the Security menu and scroll down to the Utilities menu. Select Secure Erase and
select the desired hard drive.
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Non-volatile memory usage

Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

Real Time Clock
(RTC) battery
backed-up
CMOS
configuration
memory
(CMOS)

256 Bytes No Yes Stores system
date and time
and limited
keyboard
controller data.

Using the F10
Setup utility or
changing the
Microsoft
Windows date
and time.

This memory is
not write-
protected. HP
recommends
password
protecting the
F10 Setup
utility.

Controller (NIC)
EEPROM

64 KBytes (not
customer
accessible)

No Yes Store NIC
configuration
and NIC
firmware.

Using a utility
from the NIC
vendor that can
be run from
DOS.

A utility is
required to
write data to
this memory
and is available
from NIC
vendor. Writing
data to this
ROM in an
inappropriate
manner will
render the NIC
nonfunctional.

Keyboard ROM 64 KBytes (not
customer
accessible)

No Yes Stores firmware
code
(keyboard,
mouse, &
battery
management).

Programmed at
the factory.
Code is
updated when
the system BIOS
is updated.

A utility is
required for
writing data to
this memory
and is available
on the HP
website.
Writing data to
this ROM in an
inappropriate
manner can
render the PC
nonfunctional.

DIMM Serial
Presence Detect
(SPD)
configuration
data

256 Bytes per
memory
module, 128
Bytes
programmable
(not customer
accessible)

No Yes Stores memory
module
information.

Programmed by
the memory
vendor.

Data cannot be
written to this
memory when
the module is
installed in a
PC. The specific
write protection
method varies
by memory
vendor.
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Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

System BIOS 4 to 5 MBytes Yes Yes Store system
BIOS code and
PC
configuration
data.

System BIOS
code is
programmed at
the factory.
Code is
updated when
the system BIOS
is updated.
Configuration
data and
settings are
input using the
F10 setup utility
or a custom
utility.

A utility is
required for
writing data to
this memory
and is available
on the HP
website.
Writing data to
this ROM in an
inappropriate
manner can
render the PC
nonfunctional.

Intel
Management
Engine
Firmware
(present only in
models ending
in a ‘p’ or ‘w’
or with Intel
Centrino Pro
technology)

1.5 or 5
MBytes

Yes Yes Stores
Management
Engine Code,
Settings,
Provisioning
Data and iAMT
third party data
store.

Management
Engine Code is
programmed at
the factory.
Code is
updated via
Intel secure
firmware
update utility.
Unique
Provisioning
Data can be
entered at the
factory or by an
administrator
using the
Management
Engine (MEBx)
setup utility. The
third party data
store contents
can populated
by a remote
management
console or local
applications
registered by
an
administrator to
have access to
the space.

The Intel chipset
is configured to
enforce
hardware
protection to
block all direct
read/write
access to this
area. An Intel
utility is
required for
updating the
firmware. Only
firmware
updates
digitally signed
by Intel can be
applied using
this utility.
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Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain data
when power
is removed?

What is the
purpose of
this
memory?

How is data
input into
this
memory?

How is this
memory
write
protected?

Bluetooth flash 2 MBits No Yes Stores Bluetooth
configuration
and firmware.

Programmed at
the factory.
Tools for writing
data to this
memory are not
publicly
available but
can be
obtained from
the silicon
vendor.

A utility is
required for
writing data to
this memory
and is made
available
through newer
versions of the
driver if the
flash requires
an upgrade.

802.11 WLAN
EEPROM

4 KBytes to 8
KBytes

No Yes Stores
configuration
and calibration
data.

Programmed at
the factory.
Tools for writing
data to this
memory are not
made public.

A utility is
required for
writing data to
this memory
and is typically
not made
available to the
public unless a
firmware
upgrade is
necessary to
address a
unique issue.

Webcamera 64 KBits No Yes Store
webcamera
configuration
and firmware.

Using a utility
from the device
manufacturer
that can be run
from Windows.

A utility is
required for
writing data to
this memory
and is typically
not made
available to the
public unless a
firmware
upgrade is
necessary to
address a
unique issue.

Fingerprint
reader

512 KBytes
flash

Yes Yes Stores
fingerprint
templates.

By enrolling in
HP ProtectTools
Security
Manager.

Only a digitally
signed
application can
make the call to
write to the
flash.
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Questions and answers
1. How can the BIOS settings be restored (returned to default settings)?

a. Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b. Select File, then select Restore defaults.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. What kind of configuration data is stored on the DIMM Serial Presence Detect
(SPD) memory module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial
number, data width, speed/timing, voltage and thermal information. This information is written by
the module manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the
memory module is installed in a PC. Third party tools do exist that can write to the EEPROM when
the memory module is not installed in a PC. There are various third party tools available to read
SPD memory.

3. Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip
writable, and if so how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform
the write function.

4. In some PC systems, the Firmware Hub for System BIOS is a flash memory chip
so that updates can be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.

5. What is meant by “Restore the nonvolatile memory found in Intel-based
system boards?”

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC
configuration data.

6. Does resetting the CMOS configuration memory return the PC back to
factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not
reset many of the system data and configuration defaults to their default settings. To return these
system data and configuration defaults to default settings, refer to question and answer 1 and
follow the instructions for returning the BIOS settings to factory defaults.
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9 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating
of 125 or 250 V ac, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Argentina IRAM 1

Australia SAA 1

Austria OVE 1

Belgium CEBEC 1

Brazil ABNT 1

Canada CSA 2

Chile IMQ 1

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

India ISI 1

Israel SII 1

Italy IMQ 1

Japan JIS 3

The Netherlands KEMA 1

New Zealand SANZ 1

Norway NEMKO 1

The People's Republic of China CCC 4

Saudi Arabia SASO 7

Singapore PSB 1

South Africa SABS 1

South Korea KTL 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 6

Thailand TISI 1

The United Kingdom ASTA 1
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Country/region Accredited agency Applicable note number

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark.
UL file number must be on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² or 1.25-mm² conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3X0.75-mm² conductor size. KTL logo and individual approval number must be
on each element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3×1.25-mm² conductor size. Power cord set fittings (appliance coupler, cable, and
wall plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL
and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3×0.75-/1.00-mm² conductor size, with
plug BS 1363/A with BSI or ASTA marks.
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10 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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